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ABSTRACT

The possibility of worker exposure to radioactive materials during accidents at nuclear facilities is
a principal concern of the DOE. The KBERT software has been developed at Sandia National
Laboratories under DOE support to address this issue by assisting in the estimation ofrisksposed
by accidents at chemical and nuclear facilities. KBERT is an acronym for Knowledge-Based
system for Estimating hazards of Radioactive material release Transients. The current prototype
version of KBERT focuses on calculation of doses and consequences to in-facility workers due to
accidental releases of radioactivity. This report gives detailed instructions on how a user who is
familiar with the design, layout and potential hazards of a facility can use KBERT to assess the
risks to workers in that facility. KBERT is a tool that allows a user to simulate possible accidents
and observe the predicted consequences. Potential applications of KBERT include the evaluation
of the efficacy of evacuation practices, worker shielding, personal protection equipment and the
containment of hazardous materials.
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KBERT User's Guide

1. Introduction
Accident risks faced by workers at Department of Energy (DOE) facilities are receiving
increased attention because of heightened awareness, aging of facilities, changing mission,
and the advent of new activities (e.g., decontamination and decommissioning). The
KBERT software is being developed at Sandia National Laboratories under DOE support
to address these issues by assisting in the estimation of risks due to accidents at chemical
and nuclear facilities. KBERT is an acronym for Knowledge-Based system for Estimating
hazards of Radioactive material release Transients. The current prototype version of
KBERT focuses on the calculation of doses and consequences to in-facility workers
produced by accidental releases of radioactivity. This report describes the KBERT
software and provides instructions for its use.
1.1 Overview of KBERT
The KBERT software can be used for qualitative or quantitative risk analyses, assessments
of heating ventilation and air conditioning (HVAC) systems, the evaluation of alarm
systems, and the assessment of evacuation plans. Facilities are modeled in KBERT as a
number of rooms connected by hallways, HVAC ducts, and other flowpaths. The
Mishima [1993 J database on the amounts of material released to the atmosphere as a
function of the accident and the respirable fractions of the released materials is
incorporated in KBERT as an electronic relational database that KBERT accesses
transparently to the user. There are also databases on material properties and health
effects of radionuclide exposure in the software. KBERT uses mechanistic models of
aerosol transport within a facility given user prescribed air flow rates. Filters that mitigate
radionuclide exposures in an accident can be modeled in any flowpath. Worker
movements in response to alarms can be modeled by specifying a detailed evacuation plan
for each worker or group of workers. Dose models include the effects of inhalation,
cloudshine, groundshine, and skin contamination. The effect of half or full mask personal
protection equipment is modeled, including shine protection, and skin protection. Output
from KBERT includes airborne and surface concentrations of hazardous material
throughout the facility as well as whole-body and organ-specific doses to workers.
1

1.2 Guide to this document
Chapter 2 describes how to begin using KBERT, including installing the software on the
computer where it will be used. This chapter also covers some basic information about
using software under the Microsoft Windows operating system. If you already have
KBERT installed and are an experienced Windows user, you should skip this chapter.
Chapter 3 briefly describes the models in KBERT that are used to calculate the release,
transport, and removal of radioactive material in the facility. Additional leak path models
as detailed by Heames and Brockmann [1994] could be implemented within KBERT.
The models used to calculate dose to in-facility workers are also briefly described;
however, the reader is referred to Monroe's [1994] assessment for a detailed description
2
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of the dose models. Reading this section is not required to learn how to use KBERT;
however, all users are encouraged to eventually read this section to gain an understanding
of the modeling approach and key assumptions made.
Chapter 4 provides instructions for specifying input to KBERT. All required and
optional inputs are described in this chapter, including instructions for defining the
physical facility layout, workers in the facility, events and the materials at risk, and various
options. The dialog boxes where most KBERT input is solicited are also shown and
described in this chapter. Analysts planning to use KBERT will want to read this chapter
in detail.
Chapter 5 describes how to run KBERT. Running KBERT once a facility has been
defined is quite straightforward. Most experienced analysts, particularly those
experienced in using software written for Microsoft Windows, will probably be able to run
KBERT without referring to Chapter 5. This chapter is therefore best treated as a
reference or for when one wants to perform more advanced KBERT functions.
The last chapter, Chapter 6, describes how to obtain output from KBERT. The
prototype version of KBERT only produces screen output. Like the input, the
interpretation of KBERT output is rather obvious. One not so obvious output feature of
KBERT is the inspect bar. Analysts should find this feature of KBERT invaluable for
extracting key results from an analysis. The inspect bar is described in Chapter 6 along
with a brief description of other output features of KBERT.

2. Getting Started
2.1 Hardware and software
To use KBERT, you need:

2.2

requirements

•

An IBM-compatible PC with an 80386 processor or higher, although a 486 or
higher is highly recommended.

•

Microsoft Windows 3.1 or higher.

•

VGA graphics display (SVGA recommended).

•

A mouse or compatible pointing device.

•

A hard disk with at least 10 MB of free space.
Installation

2.2.1 Required files
KBERT is distributed on two disks and is installed by first running the setup program on
disk one and following the on-line instructions. After the setup procedure is complete,
there is one more installation step that must be done manually. The next section describes
this step in detail. This step is required and cannot be skipped. If this step is skipped,
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KBERT will not be able to access the electronic materials, health effects, and
material release databases, and will abort when you try to run it.
2.2.2 ODBC database access setup
Before you can run KBERT for the first time, you must first update the ODBC catalog of
stored procedures. Microsoft Open Database Connectivity (ODBC) is a C programming
language interface for database connectivity. This will tell the KBERT application where
to find the database it needs to run. This can be done by initiating the "ODBC
Administrator" from the KBERT Application Window that will be created on your system
when you install KBERT:

Double click on the icon to initiate the application.
The "Data Sources" screen should appear.
A,ddi„*

Click on the "Add" button to create the new catalog entry.
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Enter "KBERT" for Data Source Name then click on "Select Database"
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You must then locate the file named "KBERT.mdb" in the directory where you installed
the software. Once you have found it and highlighted the file name, click on "OK".
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The highlighted line should now appear in your list of data sources. Click on "OK", close
the "Data Sources" window, and you are now ready to run KBERT.
2.3 If you're new to windows programs
This section briefly reviews some basic features of KBERT that are common to most
Windows programs If you are familiar with running other Windows applications then skip
this section.
2.3.1 Using the mouse
The mouse is used to aid in input and output. Mastering its use is essential for effective
use of KBERT. Items that may be selected with the mouse include menu choices, toolbar
buttons, dialog box options, and KBERT facility modules on screen. To select an item
with the mouse simply point to it and click the left mouse button. All KBERT facility
modules on the main screen may be selected and then moved around on the screen except
for the environment room. To move an item on the screen, point to it, press down the left
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mouse button and hold it, then move the mouse. When the item is in the desired location,
release the left button. For more information about using the mouse under Windows,
consult the Microsoft Windows manuals and on-line tutorial provided with the Windows
operating system.
2.3.2 Using the menu
Essentially all features of KBERT can be accessed using the menu. To select a menu item
point to one of the items shown and click the left mouse button. A sub-menu will appear
beneath the selected item. The specific item desired should then be pointed to and the left
mouse button clicked again. If the item has [...] after it, this will invoke a dialog box
where more choices can be made. Otherwise, the selected function will execute
immediately. For more information on menu usage, consult the Microsoft Windows
manuals and tutorial.
2.3.3 Using the toolbar
The toolbar in KBERT is an optional feature that can be turned on or off using the View
menu selection. If this feature is on, a row of small icons will be shown beneath the menu.
These icons are simply shortcuts for selecting commonly used features on the menu. To
use the shortcut, simply point to the item of choice and click the left mouse button. The
first three buttons on the toolbar are file shortcuts. The scissors icon is a delete item
shortcut, which will remove any selected modules from the facility. The next two are
shortcuts for single step run and run reset. The next six are shortcuts for adding new
objects to a facility. To find out which button does what, experiment on a sample file.
The last toolbar button is for showing the program's "about" information box. This box
shows information about the developers of KBERT.
2.4 Starting the KBERT Software
Once KBERT has been installed, running it is a simple matter of double-clicking on its
icon. You can also run KBERT by double-clicking on its name from within File Manager,
as with any other Windows application. Normally KBERT loads as a full screen
application with a generic one room facility shown on the screen. Typically you use this
simple facility as a starting point to create your own facilities, but you can delete the one
room and/or the HVAC system and start from scratch. You can also load a facility from
disk that you have created in a previous KBERT session as described in the following
section. When the KBERT icon is set up, normally no parameters are given following its
name. If instead you specify the name of a facility known to exist on your hard disk
following the program name, that facility will automatically load when you double click on
the KBERT icon.
2.5 Loading and saving files
In KBERT, all aspects of a user defined facility can be saved in a file. By default, KBERT
files are given the ".fac" extension. You can override this to give your files any extension,
but this is not recommended. Files may be saved by selecting the "Save" or "Save As"
5

option under the File menu. Alternatively, you can click the save icon on the toolbar to
save the current file. When files are saved, they are reset to time zero; therefore, analysis
results are never saved to disk. This is unnecessary due to the short run times. To review
the results of a given analysis, the file must be loaded and re-run.
Previously saved files may be loaded by selecting "Open" from the File menu. Only files
saved by KBERT may be loaded into KBERT. Any attempt to open a file not saved by
KBERT will produce an error message. If the open is successful, the facility previously
saved will be shown on screen. All facilities loaded into KBERT from disk will be set to
time zero, ready for you to start an analysis. The last four items on the File menu above
the Exit selection lists the last four files loaded into KBERT. This can be used as a
shortcut to quickly load any one of the last four files you have analyzed. Typically only
files with the ".fac" extension are listed in the Load dialog box; however, files with other
extensions can be listed by changing the selection under "List Files of Type:" on the Open
dialog box.

3. KBERT Software Description
3.1 Facility elements
The KBERT software represents facilities as a collection of interconnected elements on
the screen. The following elements are included: rooms, HVAC plenums, flowpaths,
filters, and structures. All of these, except structures, are visible on the main KBERT
screen. Although structures are not shown graphically, their attributes may be specified
from within the room definition input box (more commonly called a dialog box). Filters
are defined with the Flowpath dialog box. All other facility elements are defined from
their own dialog box that is invoked by clicking on their screen symbol from the toolbar or
via the insert menu item. Specifics about each facility element are discussed in the
sections below.
3.1.1 Rooms
Rooms are the basic components used to describe a facility. A facility is described as one
or more rooms interconnected by doorway flowpaths and/or HVAC ducts. A facility can
have any number of rooms but must always have at least one, the environment room. The
environment room is delimited by four layers of broken red lines that outline the facility
drawing. The environment room represents the out of doors and is a source of fresh air
and exhaust from the facility for ventilation systems. The environment is the only room
where an event cannot take place. Each room can contain any number of workers,
structures (floor, wall, and roof structures are used to define aerosol settling surface areas
within a room), materials at risk, and events. Rooms are shown on screen as cyan
colored squares. The height of the square is proportional to the user specified height of
the room. The width of the square is proportional to the volume of the room divided by
its height. With this approach, the size of the square shown on screen is directly
proportional to the volume of the room it represents. The location of rooms on screen are
under the control of the user (KBERT's layout does not represent a birds-eye view of the
facility). As rooms are moved, the interconnections are automatically adjusted. Users are
6

encouraged to move rooms around until a visually appealing arrangement (with few
doorway lines crossing each other) is obtained. Room physical characteristics, including
embedded structures, events, and physical size are specified in the Room dialog box. The
Room dialog box is accessed either by double clicking on the box that represents the room
of interest, or by double clicking on the room name of interest in the Run Accident
Simulation dialog box. New rooms are added to a facility by selecting the "Room" option
under the Insert menu or by selecting the button containing the cyan square in the toolbar.
3.1.2 HVAC Plenums
An HVAC plenum is a special type of room used to represent the common volume of an
HVAC system. Plenums are distinguished from standard rooms on screen by their fixed
size and purple color. Return and source vents in a given HVAC system connect to the
same HVAC plenum. When a new facility is created one HVAC plenum is automatically
included (each HVAC system has exactly one HVAC plenum). This initial HVAC system
can be kept, deleted, or additional HVAC systems can be added at the user's discretion.
Any number of plenums may be added to a given facility. Each new HVAC plenum
represents a new separate HVAC system. Air and materials drawn from rooms into one
HVAC plenum are not mixed with air and materials drawnfromrooms into other HVAC
plenums. The characteristics of HVAC plenums are defined using the same Room dialog
box described in the previous section. Doorwayflowpathscannot be connected to HVAC
plenum rooms, and workers and events are not allowed in HVAC plenum rooms. HVAC
systems are added by selecting the "HVAC System" option under the Insert menu or by
selecting the button containing the purple rectangle in the toolbar.
3.1.3 Structures
Structures are embedded within rooms and are used to define deposition surfaces for
aerosols. There are three types of structures that can be included in a room:floors,walls,
and roofs. Normally each room will contain one of each type; however, the user can
delete or add new structures prior to starting a run. The environment room is initially
created with only one structure of type "floor" that is named "ground". HVAC plenum
rooms are not allowed to contain structures. All other rooms are created with three
structures, one of each type. The area of the structures created in a room are
automatically calculated to be the appropriate areas for a cube with the volume of the
room. If you change the volume of a room KBERT will prompt you to allow KBERT to
automatically re-adjust the areas of these three default structures. In the present version
of KBERT onlyfloorstructures have an effect on analysis results, since gravitational
settling is the only aerosol deposition model included. To accommodate future KBERT
versions, where deposition mechanisms onto walls and roofs are envisioned, users are
encouraged to define rooms with the appropriate wall and roof areas as well as floor
areas. Structures are not shown visually on the KBERT screen; however, the deposition
mass on structures is shown in the inspect bar when a room is selected. Structures may be
added or removed by selecting the "Settled Matl" option button in the Edit Room dialog
box and then clicking on either the "Add" or "Del" button under the structure list on the
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left hand side. An existing structure is edited by double clicking on the appropriate name
in this list.
3.1.4 Flowpaths
Three types of flowpaths are used to connect rooms in a facility. The first type is a
standard flowpath, which is used to represent doorways, windows, and other
interconnections such as pipes. The second type is an HVAC source duct, which is used
to represent flow into a room from the HVAC plenum room as a result of the HVAC
system operation. The third type is an HVAC return duct, which is used to represent air
and airborne material flow from a room back into the HVAC plenum room.
Standard flowpaths are shown on screen as black lines. The shape of the connecting line
is automatically determined from the relative locations of the connected rooms. An arrow
is placed on either side indicating the direction of gas flow through the flowpath. If flow
is in both directions through the flowpath, an arrow will not be shown. Source HVAC
ducts are shown as red arrows on the left side of rooms. Return HVAC ducts are shown
as green arrows on the right side of rooms. Source HVAC ducts representing fresh air to
the facility and return HVAC ducts representing exhaust from the facility are shown as
green and red arrows on the HVAC plenum. The characteristics of flowpaths are
described within the Flowpath dialog box that is accessed by double clicking anywhere on
the flowpath of interest. The Flowpath dialog box can also be accessed by double clicking
on the flowpath name of interest in the Run Accident Simulation dialog box.
HVAC source and return ducts must be identified with a given HVAC plenum. HVAC
ducts can be specified in the environment room to represent fresh air flow into a facility
and exhaust from a facility. If fresh air flow is to be kept separate from facility air
recirculation, then two or more HVAC plenums should be included and the environment
HVAC ducts should be entered on a separate HVAC plenum from the other HVAC ducts.
New flowpaths are added by selecting either the "Doorway", "Source Duct", or "Return
Duct" option under the Insert menu or by selecting any of the three corresponding
shortcut buttons from the toolbar.
3.1.5 Filters
Filters may be specified to trap airborne materials on any flowpath, including doorways
and HVAC ducts and are shown on screen as rectangular gray boxes. Although one
would normally not include a filter on a doorway, this is allowed because standard
flowpaths are also used to represent pipes which can be filtered. Each filter may be given
a unique removal efficiency. Only airborne aerosol material are affected by filters; nonaerosol materials pass through filters unaffected. Filters are specified by first editing the
flowpath where they are located and then pressing the "Filter" button in the Flowpath
dialog box.

3.2 Workers
Workers are represented within a facility either individually or as groups that move
together. Each worker or worker group is represented on screen as a small yellow square
8

within one of the rooms. Workers may be movedfromroom to room at any time by
dragging the appropriate yellow box with the mouse. Workers may not be added or
dragged to HVAC plenum rooms; however, they can be added to the environment room.
Because it is easy to accidentally drag and drop a worker to the environment room, users
are prompted to confirm such an action when it occurs. Each worker or worker group
can be given its own evacuation plan which defines how the worker(s) move following the
initiation of an accident. Finally, each worker can be given personal protective equipment
consisting of either skin protection, full or half mask, self contained breathing apparatus,
and shine shielding using options in the Worker dialog box. The Worker dialog box is
accessed by double clicking on the appropriate yellow square for the worker of interest.
Workers may also be accessed by double clicking on the worker name in the Run Accident
Simulation dialog box. New workers are added to a room byfirstclicking on the room
and then selecting "Worker" under the Insert menu. Also, when a room is created the
user is asked if a new worker should be automatically added to the room.
3.3 Materials at risk and events
Materials at risk and events are specified in the Event dialog box to represent an accident
that has occurred in a facility. A new event is added to a room by selecting the
"Events/MAR" option button in the Room dialog box and then pressing the "Add" key
under the events list. This invokes an intuitive dialog box interface into the Mishima
database. This database includes data for releasefractionsand respirable fractions for
materials that have been subjected to a variety of stresses, such asfires,spills, and
explosions. KBERT does not handle criticalities. An important feature of KBERT is that
only realistic combinations of release data, stresses and materials at risk can be utilized in
the simulation. Unrealistic combinations are inaccessiblefromthe Event dialog box.
Rooms that have events and materials at risk defined in them will be shown on screen with
a red bar on the bottom.
The Mishima database accessed in KBERT provides either a one time airborne release
fraction, (ARF), or a continuous airborne release rate, (ARR (kg/s)). The mass (M) of
material released into the atmospherefroman event in a given time step is:
M=MAR-ARF
= MAR-ARR-dt

(t = t )
(t>t )
s
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where t is the event start time that is specified in the Run Accident Simulation dialog box.
Normally this start time is equal to zero. Note that the ARF is only used on thefirsttime
step. The released material will not begin to distribute through the facility and affect
workers until subsequent time steps.
When mass M is released into the atmosphere of the room, the following equation is used
to calculate the respirablefractionof the material:
s
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=

RF(t)-M(t) + RF-M
M(t) + M

where M is the mass of material released during this time step, RF is the respirable fraction
of the material at risk as taken from the database, M(t) is the mass of the same material
present in the atmosphere before this time step, and RF(t) is the respirable fraction of the
material in the atmosphere before this time step. Often, RF and RF(t) will be the same so
the above equation simply becomes RF(t) = RF. However, in cases where RF is
calculated it can change in time since RF is recalculated at the beginning of every time
step. The above equation ensures that the appropriate fraction of the airborne material is
treated as respirable.
The values of ARF, ARR, and RF are extracted from the database and shown in the Event
dialog box. If any of these values are calculated, it will not be shown. Instead, the word
"Formula" will appear. To display the calculated value, you can click on the "User
Specified" option button. This will evaluate the formula so that the initial (time = 0)
calculated value is displayed.
There are actually three values for ARF, ARR, and RF that are in the database: minimum,
nominal, and bounding values. Initially the nominal value is shown in the Event dialog
box. A pull-down menu is provided to allow the user to select and show either the
minimum, nominal or the bounding values. The Run Accident Simulation dialog box has a
similar set of option buttons that are used to dictate which set is actually used in the
analysis.
3.4 Flows and equation of state
Air and airborne contaminant flow are driven by user specified flow rates through the
flowpaths. The user is required to specify the volumetric flow rate in m /s for each
flowpath in the facility. KBERT uses the specified flow rates to move air and airborne
contaminants (aerosols and vapor phase radionuclides) between the interconnected rooms
as described below. Secondary events caused by release incidents are not simulated. Only
the events specified by the user affect air flow.
3

Air in KBERT is assumed to be composed of 79% nitrogen and 21% oxygen; however,
this can be readily made more flexible in future versions if it is determined that such
flexibility is useful. The time dependent conservation equation for gas species k in room i
is given by:
dm.i,k
dt

fm,,-0
j,k
/->»" ^

W

^ji

'X2,
- m,*

'-*j

V.

where, m;k is the mass of gas species k in room i, V; is the volume of room i, Q - is the
volumetric flow rate from room i to room j . Excluding the effects of filters, an identical
equation is used to calculate the flow of airborne contaminants with the gas flow. This
y
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approach hinges on the assumption that airborne contaminants are sufficiently small in size
and mass that they do not affect the gas flow. A rule of thumb that quantifies this
assumption is that average distance between particles is at least 10 times the particle
diameter. A further assumption is that contaminantsflowbetween rooms with the gas
flow with very little slip, i.e. at the same velocity as the flow. Technically, this is valid for
very lowflowrates, and is a reasonable approximation for most cases. Whenfiltersare
present, theflowof aerosols between rooms is modeled according to the following
modified version of the conservation equation:
dai,k

=Z

dt

j - »

a J.k

•Q,

v..

ZQ,

•a-*,) -a

>-*j

i,k

where ai,k is the mass of aerosol material k in room i, and Sji is thefilterremoval efficiency
inflowpathji. The fraction that does notflowthrough to room i gets trapped in the filter.
The enthalpyflowbetween rooms is given by a similar expression for the time rate of
change of internal energy, U, in a room:
{Ut+P.VJ-Q,
V,

dU^
dt

iu, + p v,y
t

v

;

where P is the pressure. The above equations are evaluated for all flowpaths to determine
the end of time step gas and material masses and room internal energies. Once the internal
energy is known the temperature, T, of each room can be obtained from the equation:

U = 2X*W)
t

RT,
MWt,

where R is the gas constant, MWk is the molecular weight of gas species k, and hk(T;)
represents the specific enthalpy at temperature T for species k in room i. This equation
simply equates the total energy in a room to the energy of the gases in the room. The
term in square brackets is the specific internal energy of species k. KBERT includes
specific enthalpy functions for nitrogen and oxygen gases. Note that the specific enthalpy
functions are referenced to zero at 273.15 K; therefore, the internal energy of a room, U =
H - PV, will be negative for temperatures in the 300 K range. The solution to the above
equation is obtained by iteration.
Once the temperature and gas masses of each room are known, the new pressure is
evaluated using the ideal gas law equation of state:
P.=

ni

RT

K^MWJ v,

In a uniform temperature facility, if the user specified flows are balanced (i.e., if all
incoming volumetricflowsto a room match the outgoingflows),then the pressure
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calculated from the above equation will always equal the initial pressure. This will not be
true if the flows are changing in time or if some rooms have a different initial temperature.
The above equations are solved using first order explicit time integration steps. The size
of the integration steps is controlled by the relative magnitude of the highest user specified
flow rate and the smallest room volume in the facility. The time integration step is set to
allow only 10% of the volume of the smallest room to be exchanged in a single time step.
If this constraint results in a time step larger than the user selected time step, then the flow
and equation of state integration time step is simply taken to equal the user specified time
step.
3.5 Dose and consequence models
Mechanistic models are included in KBERT for calculating dose and consequences to infacility workers. The four dose pathways considered in KBERT are inhalation,
cloudshine, groundshine, and deposition on skin. Health effects models are included for
latent cancers and acute injuries and deaths. These models are described in detail by
Monroe [1994]". Information about the specific implementation of these models in
KBERT is provided in this section. The reader is referred to Monroe [1994] for detailed
information about the dose models, including information about the dose conversion
factors.
3

Inhalation dose received by a worker in a room during a time step is directly related to the
activity in the room, the breathing rate of the worker in question, and a dose conversion
factor that relates inhaled activity to dose. The activity in the room atmosphere or air is
calculated as the sum of the activity of all airborne radioactive materials. Half lives of all
materials that can be airborne in KBERT are automatically extracted from the KBERT
materials database. A default worker breathing rate (1.7e-4 m /s) is provided, but the user
may change this to any value desired. The dose conversion factors are stored in the
KBERT database for each material. The appropriate conversion factor for each
radioactive isotope is automatically extracted from the database and used in the inhalation
dose calculation. If a worker has an evacuation plan, then the dose rate can change as the
worker moves from one room to another. The dose rate in the new room will be based on
the activity in that room. The cumulative inhalation dose received at any given time is
equal to the sum of the doses received during all time steps leading up to that time.
3

Cloudshine dose calculations follow an identical logic. The cloudshine model of course
uses different dose conversion factors from the KBERT database. Again, the appropriate
conversion factor that relates airborne activity to cloudshine dose is automatically
extracted from the KBERT database and used in the dose calculation. The cloudshine
model in KBERT is a slightly modified form of that described in Monroe [1994] which
includes a geometric factor to account for the finite nature of rooms. This factor will be
described in a forthcoming updated version of the dose report.
The groundshine model is based on the amount of radioactive material deposited on
structures in the facility. As aerosol deposits on structures, KBERT calculates the mass
and activity attributed to deposited material. The groundshine model uses this activity.
The appropriate dose conversion factor that relates surface specific activity to groundshine
12

dose for each deposited radioactive material is automatically extracted from the KBERT
database and used in the groundshine model.
The above three dose pathways are evaluated for the body organ categories list below,
where a distinct dose conversion factor is obtained from the KBERT database for each
radionuclide, dose pathway, and organ category (except skin):
Adrenals
Bone
EDE
Kidneys
Lower Large Intestine
Ovaries
Red Marrow
Spleen
Testes
Thyroid

Bladder
Breast
ICRP60ED
Liver
Lungs
Pancreas
Small Intestine
Stomach
Thymus
ThyroidH

Note that the "EDE" category on this list is an effective organ for an equivalent whole
body dose. This is the dose that is reported in the main output. The doses to specific
body organs are used in the calculation of specific health effects. The "ICRP60ED"
category is unused at this time. Categories are based on the ICRP26 standard.
6

The skin dose is evaluated for only one body organ, the skin. The model for skin dose is
similar to groundshine. The only difference is that the dose is driven by the amount of
radioactive material that has deposited onto the skin. This is calculated and stored exactly
as if the entire skin area were a floor in the room. Obviously the entire skin area will not
be horizontal facing up therefore, this assumption will result in a conservative estimate for
skin dose. Unlike the other dose models, the dose conversion factor relating activity to
dose is the same for all radionuclides in the skin dose model.
3.6 Aerosol removal by gravitational settling
Materials at risk released from events enter the atmosphere of rooms as aerosols. The size
of the released aerosol material is calculated as a function of the respirablefraction,RF,
obtained from the release database as follows :
4
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(5+RF)

ifRF=0.0
ifRF=1.0
otherwise.

m

This size is important because it is used to calculated the aerosol settling rate by gravity.
The following equation is used to evaluate the settling velocity of aerosol in a room:
y _D&ean-J000-g-C
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where \i is the viscosity of air (1.8xl0" ), g is the acceleration of gravity (9.8), X is the
mean free path of air (6.9x10' ), and F n is a slip factor (1.257). As this equation shows,
the gravitational settling velocity, V , is a strong function of the airborne particle size.
This equation was taken from the CONTAIN code from Washington [1990] which is
routinely used to perform nuclear reactor safety analyses.
5

8

s
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g
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The settling velocity is used to calculate the deposition rate of airborne aerosol on floors
and on the skin of workers in rooms. The rate of aerosol removal onto a given floor
structure is given by:
dm _
~dt~

8

A-dt
' Vol

where V is the settling velocity given above, A is the surface area of the structure or of
skin, m is the mass of aerosol in the room atmosphere, and Vol is the volume of the room.
Additional deposition mechanisms and other aerosol topics are discussed in Heames
[1994] and could be readily implemented.
g

2

4. Input Instructions
This section describes the various dialog boxes in KBERT in detail. Each of the dialog
boxes can be opened from the Insert main menu for the KBERT application or by double
clicking the facility element of interest. In each section a picture of the dialog box is
shown and each control on that box is discussed. Note also that the sub-section numbers
parallel those in Section 3.
4.1 Facility

elements

4.1.1 Rooms
Rooms are defined or modified using the Room dialog box shown below. Airborne
material may be added from the default view of the Room dialog box.
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Each control in the Room dialog box is explained below.

Room Name

Edit box used to specify a unique name for the room. This name is
referred to in the results presented in the Run Accident Simulation dialog
box and in the Inspect bar. By default a unique generic name (Room #) is
created when a new room is added, but users are encouraged to give
rooms specific names that have meaning to them.

Volume

Edit box used to specify the volume of the room. The volume must be
positive. The size of the room on screen will be proportional to the value
specified here. This value is also used to calculate the default areas of
structures created in this room.

Height

Edit box used to specify the height of the room. The height of the room
on screen will be proportional to this value. This value is also used to
calculate the aerosol gravitational deposition rate and the default areas of
structures in the room.

Elevation

Edit box used to specify the vertical elevation of the room, where 0 is the
ground floor. This value is presently unused, but users are encouraged to
specify realistic values here because future flow models will make use of
this information to calculate gravitational head.

16

Pressure

Edit box used to specify the initial pressure of the room. This value is
presently not used, but it is calculated to change in time as gases flow
through the facility. Future flow models in KBERT will make heavy use
of this input.

Temperature

Edit box used to specify the initial temperature of the room. Like the
pressure, room temperatures are calculated as materials flow according to
user specified flow rates. Future flow models wilt make heavy use of this
input.

Constant P?

Check box used to tell KBERT to bypass the equation of state calculation
for pressure in this room. If this is done, the pressure will always equal
the initial pressure. To avoid inconsistencies, the equation of state will be
used to calculate a temperature consistent with the initial pressure and the
internal energy in the room.

Option buttons

A group of three option buttons, labeled Airborne Matl, Settled Matl, and
Event/MAR used to select what is shown in the two list boxes in the
middle of the dialog box. Only one of these buttons can be selected at a
given time. When a different button is selected, the dialog box changes to
show different information. The effect of selecting different option
buttons is discussed further in the description of the list boxes below.

Airborne Matl

List box showing all materials initially present in the room atmosphere.
This list box is only shown when the Airborne Matl option button is
selected. Selecting any material in the list will result in the mass present
being displayed in the Initial Mass and Current Mass edit boxes at the
bottom of the dialog box. Double clicking on any material in the list will
invoke the Materials dialog box described in Section 4.3.3.

Settled Matl

List box showing materials present on a structure in the room. The
materials shown are those on the structure highlighted in the Material
Location list box (see the Edit Room dialog box view with the Settled
Matl option selected above). The Settled Matl list box takes the place of
the Airborne Matl list box when the Settled Matl option button is selected.
Selecting any material in the list will result in the mass present showing in
the Initial Mass and Current Mass edit boxes at the bottom of the dialog
box. Double clicking on a material in the list will invoke the Materials
dialog box described in Section 4.3.3.

Material Location

List box showing the names of all structures in the room. Selecting any
structure in the list will cause the materials on that structure to be listed in
the Settled Matl list box (see the Room dialog box view with the Settled
Matl option selected above). Double clicking on a structure in the list will
invoke the Structures dialog box described in Section 4.1.3.
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Matl At Risk

List box showing all materials atriskpresent in an event in the room. The
materials shown are those associated with the highlighted event in the
Event list box (see the Room dialog box view with the "Events/MAR"
option selected above). The Matl At Risk list box takes the place of the
Airborne Matl or Settled Matl list boxes when the "Events/MAR" option
button is selected. Typically there will be one material associated widi a
given event; however, KBERT is not restricted to this. If multiple
materials are present the mass shown in the Initial Mass and Current
Mass edit boxes are the masses of the highlighted material at risk.

Add

Push buttons used to add objects to a room. The "Add" button on the left
is used to add structures to the room if the "Settled Matl" option button is
selected. An event may be added if the "Events/MAR" option button is
selected. If the "Airborne Matl" option button is selected, the "Add"
button on the left is not shown. The Add button on the right is used to add
materials to either the atmosphere (if the "Airborne Matl" option button is
selected) or a structure (if the "Settled Matl" option button is selected). If
the "Events/MAR" option button is selected, the Event dialog box will be
invoked (see Section 4.3). This is done because KBERT only allows
certain materials to be added to certain events.

Del

Push buttons to delete objects from a room. The button on the left is used
to delete structures from the room if the "Settled Matl" option button is
selected. The highlighted event will be deleted if the "Events/MAR"
option button is selected. If the "Airborne Matl" option button is selected,
the "Del" button on the left is not shown. The "Del" button on therightis
used to delete materials from the atmosphere (if the "Airborne Matl"
option button is selected), from a structure (if the "Settled Matl" option
button is selected), or from an event (if the "Events/MAR" option button
is selected). After the "Del" button is pushed a confirmation dialog box
will be shown; if No is selected the item will not be deleted; if Yes is
selected the item is deleted.

4.1.2 HVAC Plenums
HVAC plenums are special types of rooms (see Section 3.1.2). The input options
available in the Room dialog box apply also to HVAC plenums with one exception. The
option buttons normally provided in the Room dialog box are not shown for HVAC
plenums. This is because structures and events may not be added to HVAC plenums.
4.1.3 Structures
The Structures dialog box shown below is used to specify the name, area, and temperature
of a structure within a room. The Structures dialog box is opened from the Edit Room
dialog box when the "Settled Matl" option is selected. Double clicking the structure of
interest in the material location list will open the dialog box.
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Each option in the Structures dialog box is explained below.
Structure Name

Edit box used to specify a unique name for the structure.

Surface Area

Edit box used to specify the surface area of this structure exposed to the
atmosphere of the room where this structure is located.
Edit box used to specify the temperature of the structure. KBERT does
not calculate changes in structure temperature, so this value is used
throughout the entire analysis.

Temperature

Push button used to invoke the Edit Materials dialog box. This dialog box
is used to specify materials on the structure. If radioactive materials are
added to structures, they will contribute to the shine dose calculation.
Materials are added by the software to floor structures throughout the
analysis as a result of aerosol deposition by gravitational settling. This
button is only used to manually add additional materials.

Materials

4.1.4 Flowpaths
4.1.4.1 Standard flowpaths
Standard flowpaths represent doorways, windows and other interconnections such as
pipes, and are defined or modified using the dialog box shown below.
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If the check box to calculate flow rates on the bottom of this box is selected, the flowpath
edit box changes as follows:
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Each option is discussed below.
Flowpath Name

Edit box used to specify' a unique name for the flowpath.

Room A Name

Drop down list to select one of the rooms to which the flowpath connects.

Room B Name

Drop down list to select one of the rooms to which the flowpath connects.

Pos A->B

Edit box to specify flow rate in m /s from Room A to Room B. Note that
a negative flow rate should never be specified. To represent flow from
Room B to Room A, a positive value should be specified in the Neg B->A
edit box described below. Flow can be specified in bodi directions by
specifying a value in both edit boxes. This edit box is only available when
the check box to calculate flow rates is not selected.

Neg B->A

Edit box to specify flow rate in m /s from Room B to Room A. Note that
a negative flow rate should never be specified. To represent flow from
Room A to Room B, a positive value should be specified in the Pos A->B
edit box described above. Flow can be specified in both directions by
specifying a value in both edit boxes. This edit box is only available when
the check box to calculate flow rates is not selected.

Area

Edit box to specify area of the flow path in meters . This edit box is only
available when the check box to calculate flow rates is selected.

Length

Edit box to specify length of the flow path in meters. This edit box is only
available when the check box to calculate flow rates is selected.

Flow Coef

Edit box to specify the loss coefficient of the flow path. Values on the
order of 1.0 are typical for this value. This edit box is only available
when the check box to calculate flow rates is selected.

3

3

2
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Swap

Push button to swap the names of Room A and Room B. This is needed
to reverse theflowsbecause the input checks do not allow one to set
Room A name equal to Room B.

Filter

Push button to invoke the Filter dialog box. This dialog box is used to
define the removal efficiency of thefilterin the flowpath. Note that all
flowpaths have afilter;however, initially thefilterremoval efficiency is
set to zero. Onlyfilterswith non-zero removal efficiencies are shown on
the main screen.

Materials

Push button to invoke the Materials dialog box for filters. This is simply
a shortcut tofirstpushing thefilterbutton and then pressing the materials
button in the Filter dialog box.

Flow Profile

Push button to invoke the Flow Profile dialog box. This dialog box is
used to specify flow rates in both directions as a function of time and is
shown and discussed in the Section 4.1.4.3. This option is only available
when the check box to calculateflowrates is not selected.

Zero HVACs

Push button to set theflowrates in all HVAC flowpaths to zero. When
this button is pushed the following Value Input dialog box is presented to
the user to select the time beyond which theflowswill be zero.

; 2&m tail MVACs after what time {&} *?

M
,i

This feature is useful for simulating the shutdown of the HVAC system in
a facility. To turn on the HVAC system after it has been turned off, use
the time dependentflowprofiles described in section 4.1.4.3.
4.1.4.2 HVACducts
HVAC ducts are specified using the dialog box shown below, which is similar to the
dialog box for standard flowpaths.
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The one difference between this dialog box and the standard flowpath box is that the
Room A drop down list only contains a list of the HVAC plenums in the facility. This is
done because HVAC ducts connect rooms to HVAC plenums. Therefore, all HVAC
ducts must have an HVAC plenum as the "Room A" room. Notice also that the "Swap"
button is grayed and not available in the HVAC Duct dialog box because again, the
"Room A" room must be an HVAC plenum.
4.1.4.3 Time dependent flow profiles
Flow rates as a function of time for standard flowpaths and HVAC ducts can be specified
by pressing the "Flow Profile" button in the Flowpath dialog box. When this is done the
following dialog box is shown.
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The controls in this dialog box are described below.
Selected Grid
Value

Edit box used to change values in the transient flow rate table.

Time

The first column in the table which holds the time values which determine
when during the simulation the forward and reverse flow rates will take
effect.

+Rate

The second column in the table holds the flow rates in the positive
direction which will occur during the simulation. The rates specified here
are multiplied by the Forward Flow multiplier described below. Typically
one would specify 1.0 for the Forward Flow multiplier to negate its effect
when using the table to supply specify time-dependent flow values.

-Rate

The third column in the table holds the flow rates in the negative direction
which will occur during the simulation. The rates specified here are
multiplied by the Reverse Flow multiplier described below. Typically one
would specify 1.0 for the Reverse Flow multiplier to negate its effect
when using the table to specify time-dependent flow values.

Forward flow

An edit box used to set the steady-state value of the flow rate in the
positive direction in the event that the transient flow rate table is not used.
As noted above, the value here is multiplied by the values in the +Rate
table. By default the flow rate table has no affect because it has all 1.0s
in it.
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Reverse flow

An edit box used to set the steady-state value of the flow rate in the
negative direction in the event that the transient flow rate table is not used.
As noted above, the value here is multiplied by the values in the -Rate
table. By default the flow rate table has no affect because it has all 1 .Os
in it.

Flowpath Name

An edit box used to set the name of the flowpath so that it can be
identified elsewhere in the program, such as in the Run Accident
Simulation dialog box in the list of ducts.

RampTime

The Ramp Time button brings up a dialog box which allows you to reset
the time column to evenly spaced values between zero and the ending time
as specified below:
Value Input
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The Ramp Up button brings up a dialog box which allows you to set the
selected flow column (+Rate or -Rate) to evenly spaced values between
zero and the ending value as specified below:

"Hangup to What value |m3#s)

The +Rate column will be used if the mouse if first clicked on that column
before the Ramp Up button is pressed. The -Rate column will be used if
the mouse if clicked on that column before pressing the Ramp Up button.
Ramp Down

The Ramp Down button brings up a dialog box which allows you to set
the selected flow column (+Rate or -Rate) to evenly spaced values
between the value specified below down to zero:
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« Cancel

Flat Profile

The Flat Profile button brings up a dialog box which allows you to set all
the selected flow column's values (+Rate or -Rate) to the value specified
below:
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4.1.5 Filters
Filters may be added to any flowpath and simulate the removal of contaminant from the
air.

Katae al Howpafti Ftlfe*»treated In;
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No Removal Capability
; filter Catleclkm'
Total Trapped Mass |kgj
0.
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The controls in this dialog box are described below.
Filter Name

An edit box used to set the name of the filter so that it can be identified
elsewhere in the program.

Location of Filter

A display only box used to show the name of the flowpath where the filter
resides so that it can be identified elsewhere in the program, such as in the
Run Accident Simulation dialog box in the list of ducts.
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Filter Type

A pull-down menu which lists the available pre-programmed choices for
filter type, as shown below. The menu can be accessed by clicking on the
right side of the box on the downward pointing arrow. This action will
display the list as shown below. You may then select an option with a
single mouse click. Each option has an associated collection efficiency
value which is displayed in the edit box at the bottom left corner of the
screen. The "User Specified" option does not suggest a value but lets you
set the collection efficiency to any value between 0 and 100%.

Hmie «f Flbwpath FSleYts ILe&aUtti »£-
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HEPA (0.9 to 0.9997)

Sand Bed (0.99)
Water Spray Scrubber (0.9 to 1.0)
Wet Bed Scrubber (0.75 to 1.0]
Electrostatic Precipitator (0.9 to 0.99)
User Specified
No Removal CaDabilitv

Collection
Efficiency

Total
Trapped Mass
Materials

An edit box which allows you to set or modify the filter collection
efficiency to any value between 0 and 100%. The value may be changed
by typing in the box or by using the up and down arrows on the right side
of the box.
This box is display only and shows the total amount of material trapped
by thefilterat the current time in the simulation.
This button invokes the Materials dialog box which allows the user to
assign an initial amount offilteredmaterial to a flowpath filter. This
dialog box is described in section 4.3.3.

4.2 Workers
4.2.1 Physical characteristics
Any definition of or modification to the physical characteristics of a worker must be done
from the Worker dialog box.
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The controls in the Worker dialog box that control physical characteristics are explained
below:
Worker or
Group Name

This edit box is used to specify a unique name for the worker or group of
workers. This name is referred to in the Run Accident Simulation dialog
box and in the Inspect bar. A unique name is assigned by default when
the worker or group is created.

Room Name

This display-only box shows the name of the room where the worker or
group was created. This will be the initial location of the worker at the
start of the simulation. This value can be modified by dragging and
dropping the worker symbol, a small yellow square, from its current start
room to another room. This may be done from the facility view screen.
Any number of worker groups may start the simulation in the same room.
Their evacuation paths may vary to realistically simulate possible accident
scenarios.

Breath rate

The average adult male breathing rate is shown above and is the default
value used for inhalation dose calculations. Average values for males
were used for workers because these numbers were readily available.
This value may be set by the user, for example, to account for anxiety or
movement.

Skin area

The average adult male exposed skin area is shown above and is the
default value used for skin deposition calculations. This value may be
modified by the user from the Worker dialog box.
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Mass

The average adult male weight is shown above and is the default value
used for dose calculations. This value may be modified by the user from
the Worker dialog box.

Number of Workers
in This Group
A worker symbol can indicate any number of workers who all evacuate
together along the same route and at the same time. Set the number of
workers to the number that you would like to be present in this group.
4.2.2 Dose shielding factors
A single pull-down menu in the Worker dialog box controls the dose shielding factors:
Pre-defined worker
attributes
This pull-down menu is activated by clicking on the down-arrow on the
right side of the box. This will bring up a list of choices of worker
protection devices. When a selection is made, the protection factors
associated with the choice will appear in the four categories of dose
shielding factors. If "User defined" is selected, the four dose shielding
factors will become accessible for editing and the user may then input
values between 0 and 1.
Dose Shielding
Factors

There are four factors that influence radiation dose for KBERT. They
include: Inhalation, Cloudshine, Groundshine and Skin Dose. A value of
1 in a category implies full exposure to the hazardous material; 0 in a
category implies full protection.

4.2.3 Evacuation plans
Each worker or worker group can be assigned a particular evacuation path, which consists
of a list of rooms visited and the time spent in each room during the evacuation. The
evacuation plan is specified by pressing the "Evacuation" button in the Worker dialog box,
which brings up the following Evacuation dialog box.
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Each control in the Evacuation dialog box is explained below:
Worker Name

This display only box is used to specify a unique name for the worker or
worker group.

Initial Room

This display only box is used to specify a unique name for the initial room
where the worker will begin the simulation.

Available Rooms

This box contains the names of all the rooms in the facility. The user can
choose from this list when specifying the sequence of rooms along the
evacuation route of the worker(s).

This control will add the selected room from the Available Rooms list to
the evacuation plan. The room will be added immediately after the room
that is currently selected in the evacuation plan.

JHVHHIHHH'

This control will remove the selected room from the evacuation plan.
Evacuation Plan

The evacuation plan lists the rooms that the worker(s) will visit while
evacuating. The rooms are listed in the order in which the worker(s) will
visit them. The time on the left side of each room in the plan indicate the
amount of time the worker(s) will spend in that room. The worker must
always begin the simulation in the room where the worker was created.
The worker will remain in the last room on the evacuation plan for the
duration of the simulation.
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Seconds, Minutes,
Hours
These controls are used to add or subtract the indicated time unitfromthe
duration time of the currently selected room in the evacuation plan.

4.3 Materials at risk and events
4.3.1 Mishima database
Access to the recommended release values from the Mishima [1993] database is through
the Event dialog box shown below. The Event dialog box is opened from the Edit Room
dialog box when the Events/MAR option is selected. Pressing the "Add" button or double
clicking an existing event will open the dialog box.
1

The controls in the Event dialog box which access the Mishima database are in the section
labeled "Airborne Release" and are explained below:
ARF

ARR

fraction

The airborne releasefraction,takenfromthe Mishima database, indicates
thefractionof the material at risk that will be released when the event
commences.
The airborne release rate, takenfromthe Mishima database, indicates the
rate at which the material at risk will be released into the surrounding air
for the duration of the event. The duration is specified in the duration edit
box explained in the following section, 4.3.2.
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Respirable
Fraction

Jofu Reference

Calculated/
User Input

Attributes

The respirable fraction, takenfromthe Mishima database, indicates the
portion of the airborne material which is small enough to be inhaled
deeply, i.e. < 10 u,
The number given indicates the section of Jofu Mishima's draft report
where the user couldfinddocumentation of thefractionsused for the
simulation.

1

Only one of these two buttons can be in effect at any given time. When
"Calculated" has been chosen, this signifies that the values provided by
the Mishima database will be used for the simulation. Also, the user may
be required to supply some attributes so that the formulae can be
evaluated in an accurate manner. When "User Input" is specified, this has
two effects. First, any value which had the term "Formula" will be
evaluated for the specific circumstances specified. Second, the user will
be permitted to supply their own values for the threefractions.Material
from the materials database can be added according to the rates of any
user-defined scenario. Using this option, accidents are not restricted to
those experimentally examined by Mishima[1993]'; however, caution
must be exercised to specify defensible values since KBERT makes no
sanity checks on the user specified values.
When "Calculated" has been specified, the user may be asked to supply
some user selectable attributes that will be used in the formulation of the
three values above (ARF, ARR, RF).

4.3.2 Event attributes
In the Event dialog box shown above, the controls which pertain to the event itself follow:
Event Name
Material Initial
State Category

This edit box is used to give a unique name to the event.
This pull-down menu is used to select the appropriate initial state of the
material at risk. The selection made here is used to provide appropriate
choices in the Event Type list.

Start

This edit box is used to specify the time at which the event will
commence.

Duration

This edit box is used to specify the length of time that the event will
continue to release the material at risk.

Event Type

This pull-down menu allows the user to select the major type of event that
caused the release of material. The selection made here is used to provide
appropriate choices in the Event Subtype list below.

Event Subtype

This pull-down menu allows the user to select the specific event based on
the event type and initial state selected.

Matl Database

This list box shows all the materials which could be involved in the
accident described by the material initial state and event type and subtype.
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Materials At Risk After the user selects a material from the Matl Database list box and uses
the right arrow button, the material will become at risk during the
simulated event and show up in this display box. Typically there will be
only one material at risk; however, multiple materials can be selected and
added to the list if the user so chooses.
Initial Mass

The user may define the amount of material at risk that will be involved in
the event during the simulation using this edit box. The up and down
arrows on the right side of the edit box may be used to change the amount
of initial material mass that is displayed in the box. If there are multiple
materials at risk, then the initial mass will be for the material selected in
the materials at risk list.

4.3.3 Adding materials outside of events
Materials can be manually added to the following facility objects: room atmospheres,
structures, workers, and filters. The "Add" button of the Airborne Material section of the
Edit Room dialog box allows addition of material directly into the room atmosphere. The
"Materials" button of the Structures dialog box allows addition of settled material directly
into the surface of the structure indicated. The structures typically include walls, floors
and roofs chosen from the Settled Material/Material Location section of the Edit Room
dialog box. Material may be deposited directly onto the skin of a worker by pressing the
"Materials" button of the Worker dialog box. Material may be deposited directly onto a
filter or flowpath by selecting the "Materials" button from either the Flowpath or Filter
dialog box. Any of these actions will invoke the Materials dialog box described below:

Location

Static box showing the location of the materials. The location cannot be
changed; this is simply to remind the user where the material is being
added.
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Materials Database List box showing all the materials available in the materials database.
Any material from the database can be added by selecting it with the
mouse and then pressing the "Add" button (see below).
Materials Present

\U(«ll((ltllf

List box showing all the materials present in the facility at the location
given in the Location edit box. The amount of each material is shown in
the Initial Mass box when that material is highlighted.

Push button used to add the selected materials from the database to the
location. If the material is being added to the room atmosphere a Pick
Type dialog box is shown (see below) where the user must select to what
extent the added material is respirable.
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Standard Material will add the material as an airborne gas. If this type is
selected the material will not be trapped by filters and it will not deposit
by gravitational settling. If any of the other types are selected, the
material will be added as an aerosol. The size of the aerosol will be
governed by the formula given in the beginning of section 3.6, where RF
is 0 for Non Respirable, 0.5 for Half Respirable, and 1.0 for Totally
Respirable.
If the material is being added to any other location, this list is not shown
since only airborne materials can be respirable.

wmtk
Push button used to remove the materials selected in the Materials Present
list box.
Initial Mass

Edit box used to specify the initial mass of the material selected in the
Materials Present list box.

Current Mass

Static box showing the mass of the material selected in the Materials
Present list box. At the start of a calculation this value will always equal
the value in the Initial Mass box. After a calculation has begun, the
amount remaining is shown. This might differ from the initial amount
because of either aerosol transport (deposition) or because of radioactive
decay.
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4.4 Miscellaneous user options
4.4.1 Zoom in and out
The "Zoom" functions are accessible from the center section of the View menu.
Zoom In

This menu selection causes the rooms to enlarge by about 50%. HVAC
ducts remain the same size and hold their current screen coordinates.
Filters also retain their original size. Ducts adjust their location to
maintain the connection between their starting and ending rooms.

Zoom Out

This menu selection causes the rooms to reduce by about 50%. Other
facility elements react as they do when zooming in.

4.4.2 Dots representing airborne material
The number of dots used to represent the total airborne material in the facility can be set
from the Value Input dialog box shown below. This screen can be accessed from the
"Mass Dots" selection of the View menu.
Value Input
Clamber «f dei»%"rt$y fadlliy mms"
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OK
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Number of dots

The number of dots that will visually represent the total mass of material
at risk within a facility can be adjusted by either typing a new value into
the edit box or by using the up and down arrows located at the right edge
of the edit box. The larger the number specified, the greater the number
of dots that will appear in any room which contains airborne material. The
value also affects the number of dots shown representing material trapped
in filters.
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5. Running KBERT
The previous chapters have described how to build facility models within the KBERT
software. This chapter will describe how to run KBERT. To perform an analysis with
KBERT one must specify an appropriate time step and accident duration. This is done
from the Run Accident Simulation dialog box. The problem can then be run as a series of
time steps or continuously. Most of the time users will perform analyses using the Run
Accident Simulation dialog box; however, single steps can be taken while viewing the
main KBERT screen. Section 5.1 describes the controls in the Run Accident Simulation
dialog box, and Section 5.2 describes the options available for single stepping while
viewing the main KBERT screen.

5.1 Run Accident Simulation dialog box
The time step used in KBERT must be specified in the Run Accident Simulation dialog
box. This is true even if the single step analysis method is being used. This dialog box is
invoked by selecting "Go" under the Run menu. The time step is changed simply by
editing the value in the Time Step edit box. The simulation may then be run using the
buttons in the upper right corner of the dialog box.
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The time information and control boxes and the buttons that control running of the
simulation are described below:
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Time

This display-only box tells the user what time it is during the simulation.
The simulation always starts at time zero and all times are displayed in
seconds.

Time Step

This edit box allows the user to view and modify the size of the steps, in
seconds, that will be taken during the simulation. This determines the
discrete steps at which the user may halt the simulation and examine the
status of the facility elements.

Stop At

This edit box allows the user to view and modify the time, in seconds, at
which the simulation will halt. If the user wishes to continue the
simulation when the stop time is reached, the stop time can be increased
and the simulation resumed.

Steps Taken

This display-only box tells the user how many steps have been taken at the
current point in the simulation.

Steps Remain

This display-only box tells the user how many steps remain to be taken at
the current point in the simulation.

Run

This button starts or resumes the simulation so that it runs unencumbered
until the end time is reached or until the "Stop" button is clicked.

Step

This button commences the simulation and advances the time by one step.
This can be very useful for watching the status of rapidly changing
facility elements.

Stop

This button pauses the simulation so that the status of the facility elements
may be examined. A limited number of things can also be changed when
the problem is stopped, including the time step and worker locations.
Most other parameters can only be changed when the problem is at time
zero.

Reset

This button resets the simulation to time zero.

Sensitivity Options This group of buttons is used to identify which of the three release
fraction options will be used in the analysis. In the Event dialog box a
similar set of buttons is provided for viewing the three sets of ARF, ARR,
and RF values. In the Run Accident Simulation dialog box, the buttons
are used to select which set to actually use.
5.2 Single step analysis
Users are encouraged to take a few single steps before running their problems
continuously. The easiest way to do this is to press the "Step" button on the bottom of
the Inspect bar while the main KBERT screen is showing. The screen will be updated to
reflect the progression of time. The "Step" button can be pressed multiple times and the
problem will continue to advance. After a few steps have been taken, the Run Accident
Simulation dialog box can then be invoked so that a continuous run can be made. Single
steps can also be taken from the Run Accident Simulation dialog box by pressing the
"Step" button in the dialog box. This method is typically less desirable than using the
Inspect bar or the Toolbar because the Run Accident Simulation dialog box covers most
of the KBERT graphical screen view. This approach is desirable if you want to view
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precise quantitative information about a given room or worker as steps are taken. To do
this select the room or worker of interest, then press "Step". The values in the Run
Accident Simulation dialog box will be updated with the analysis results.
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6. Viewing Output
6.1 Output in the Run Accident Simulation dialog box
6.1.1 Room output
This screen can be accessed from the Run Accident Simulation dialog box by selecting the
"Rooms" radio button under the Output Options section of the dialog box.
Run Accident Simulation
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Each control and output display box for the Rooms view of the Run Accident Simulation
dialog box is explained below:
Rooms

This list box shows all the rooms in the facility. The blue bar indicates
the currently selected room, which can be changed with a mouse click on
the new room of choice. All the list boxes to the right of the rooms box
display information about the room of choice.

Respirable Cone:

This display-only list box shows the current respirable concentration of
material at risk within the selected room. As the simulation progresses,
this value will adjust as the conditions in the room change.

Airborne Cone:

This display-only list box shows the current airborne concentration of
material at risk within the selected room. If the particle size is large, there
will typically be more airborne material than respirable material.
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Deposited Mass:

This display-only list box shows the amount of deposited mass in the
selected room. This value will include the mass deposited on any of the
surfaces that the room contains.

Pressure:

This display-only list box shows the current air pressure in the selected
room.

Temperature:

This display-only list box shows the current temperature in the selected
room.

Gas Density:

This display-only list box shows the density of the gas in the selected
room.

6.1.2 Worker output
This screen can be accessed from the Run Accident Simulation dialog box by selecting the
"Workers" radio button under the Output Options section of the dialog box.
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6.1.2.1 Dose results
Each control and output display box for the dose results section of the Workers view of
the Run Accident Simulation dialog box is explained below:
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Workers

This list box shows all the workers or worker groups in the facility. The
blue bar indicates the currently selected worker(s), which can be changed
with a mouse click on the new worker(s) of choice. All the list boxes to
the right of the Workers box display information about the worker(s) of
choice.

Current Location

This display-only list box shows the name of the room where the selected
worker(s) is located at the current time in the simulation.

Inhalation Dose

This display-only list box shows the total inhalation dose received thus far
by the selected worker. If a group of workers is involved, each worker
will have received the dose displayed.

Cloudshine Dose

This display-only list box shows the total cloudshine dose received thus
far by the selected worker(s).

Groundshine Dose This display-only list box shows the total groundshine dose received thus
far by the selected worker(s).
Skin Dose

This display-only list box shows the total skin dose received thus far by
the selected worker(s).

Skin Mass

This display-only list box shows the total mass of material deposited on
the skin of the selected worker(s) thus far in the simulation.

6.1.2.2 Health

effects

Each control and output display box for the health effects section of the Workers view of
the Run Accident Simulation dialog box is explained below. This section of the dialog box
becomes visible when the "Show Health Effects" button is pushed. It can be removed by
pushing the "Hide Health Effects" button.
Health Effects

The health effects fall into three categories: d, i and c. This indicates the
probable consequences that would result from this health effect:
d
death
i
injury
c
latent cancer
The health effects included in KBERT thus far include only those known
to result from radiological exposure. For more information on dose and
health effect determination, the reader is referred to Monroe's [1994]
assessment.
3

Organ

This display box shows the major organ that is affected by the health
effect currently selected.

Risk

This display box shows the risk factor for the health effect currently
selected. For a reading of 10%, this would indicate that if 100 people
were exposed to the conditions of the simulation, it is estimated that the
dose level would be expected to induce the specified health effect in ten
people. The estimate is derived from existing field or clinical data.
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6.1.3 Flowpath output
This screen can be accessed from the Run Accident Simulation dialog box by selecting the
"Ducts" radio button under the Output Options section of the dialog box.
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Net Flow B a l k

1.13830E+000 m3/«

I * Calculated?:

FALSE

Each control and output display box for the Ducts view of the Run Accident Simulation
dialog box is explained below:
Ducts

This list box shows all the flowpaths in the facility. The blue bar
indicates the currently selected flowpath, which can be changed with a
mouse click on the new flowpath of choice. All the list boxes to the right
of the Ducts box display information about the flowpath of choice.

Filter Removal Eff It is possible to have afilteron any flowpath in a KBERT facility. This
display-only list box shows the removal efficiency of thefilterfor the
selected flowpath. If there is nofilteron the chosen flowpath, the removal
efficiency will be zero.
Accumulated Mass This display-only list box shows the mass of the material that has
accumulated thus far on thefilterin the selected flowpath. If no filter
exists on this flowpath, the accumulated mass will be zero. Mass is not
allowed to settle in an unfiltered flowpath.
Forward Flow Rate This display-only list box shows the rate of flow through the flowpath in
the positive direction (as defined at creation) at the current time in the
simulation. This flow rate will be updated as the simulation progresses.
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Reverse Flow Rate This display-only list box shows the rate of flow through the flowpath in
the reverse direction (as defined at creation) at the current time in the
simulation. This flow rate will be updated as the simulation progresses.
Air may be flowing in both directions through a flowpath at any given
time.
Net Flow Rate

This display-only list box shows the net rate of flow through the flowpath
of choice at the current time in the simulation. The value will be positive
if the net flow is in the positive direction (as defined at creation) and will
be negative if the net flow is in the negative direction.

Is Calculated?

This display-only list box can be either true or false:
True:

The flow rate is calculated based on the flow rates in the
rest of the facility. This is specified by the user from the
Flowpath dialog box by clicking on the "Check here to
calculate the flow rates" option.

False:

The flow rate is specified at all times by user input. This
can be done using the "Flow Profile" button from the
Flowpath dialog box or by specifying the forward and
reverse flow rates from the Flowpath dialog box.
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A rough visual estimate of the flow of contaminant through the facility can be attained
from the facility view as shown above. The contaminant can be seen in the form of black
dots which appear mostly in Cell 6 & 7, the room where the event has occurred. The
contaminant has spread to the Vent Duct room, the Pipe Tunnel, the Makeup Room, the
C6Door, and several filters. In reality, the contaminant is also present in the other rooms
but the concentration is too low to be visible from the facility view. The controls are
described below:
The step button can be used to step through the simulation while in the
facility view. This allows the user to watch the material spread through
the facility in the form of black dots that initially appear in the room with
the red bar where the event occurs, then spread throughout the facility and
deposit on filters. The dots disappearfromthe screen as the material
settles onto surfaces. The total number of dots can be setfromthe View
menu via the "Mass Dots" option.
B*£<i{

M

tftf'ff

The reset button allows the user to reset the simulation.
These two buttons perform the same functions as the "Step" and "Reset"
buttons of the inspect bar.

Time, Step & Stop These display-only edit boxes on the inspect bar shows the current status
of the simulation. Time shows the current time, Step shows the amount of
time that a step will advance and Stop shows the time at which the
simulation will halt.
6.3 Using the inspect bar
The inspect bar gives the user detailed information about the selected facility element in
the facility view. Different information is displayed depending upon the type of facility
element that is selected. The three types of elements and the values available are
presented below:
HHWW.HM^i.nni+MMitiiiwMmwmm.HWM.MAM.'.'.'.'.

Cell 6fc7

I

11

Doorway 12

Cell 6 & 7 Worker

FTM:1.000E-003k<
FTE:-1.883E+008J
Fdt: 1.000E-001 *

FTM: 1:000E-0Q3 k
FTE:-1.883E+008J
Fdt: 1.000E-001 s

FTM: 1.000E-003 k<
FTE:-1.883E+008J
Fdt: 1.000E-001 s

TM: 8.782E-004 kg
RM: 4.391 E-004 kg
TAM: 8.781 E-004 kg
TAC:1.192E-00GkgAr
TDM: 7.262E-008 kg

User Input
Pos:1.138E+000m3/s
Rev: O.OOOE+000 rn3/s
PML 1.000E+000 m3/s
RMLi1.000E+000m3/«

NUM: 1.000E+000
BR: 1.700E-004 m3/s
SA:1.800E+000m2
SFI: 2.000E-002

TAA: 5.444E+011 Bq
TRA: 2.722E+011 Bq

Filter

P:1.000E+005Pa
T: 3.000E+002 K
E: -5.050E+007 J
M: 2.953E+001 kmoled.
R:1.157E+O00kq/m3

Eff: 9.900E-001
Mass: 1.81OE-005 kg
From Environment
To C6 Door
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IDose: 2.421E-001 Sv
CDose: 1.200E-010Sv
GDose: 5.017E-013Sv
SDose: 3.407E-008 Sv
INR: Cell 6 & 7
CUR: Cell Gfc7
MXR: Cell 6 & 7
MXD: 1.110E-001 Sv/s

The values shown above in the three views of the inspect bar represent the following:
Room View

Facility Total Mass, Facility Total Energy, Facility Time Step, Total
Mass, Respirable Mass, Total Airborne Mass, Total Airborne
Concentration, Total Deposited Mass, Total Airborne Activity, Total
Respirable Activity, Pressure, Temperature, Energy, Gas Density.

Flowpath View

Facility Total Mass, Facility Total Energy, Facility Time Step, Positive
Flow Rate, Reverse Flow Rate, Positive Flow Multiplier, Reverse Flow
Multiplier, Filter Removal Efficiency, Filter Accumulated Mass,
Direction of Positive Flow.

Worker View

Facility Total Mass, Facility Total Energy, Facility Time Step, Number
of Workers in the Workgroup, Breath Rate, Skin Area, Inhalation
Shielding Factor, Inhalation Dose, Cloudshine Dose, Groundshine Dose,
Skin Dose, Initial Room, Current Location, Room where maximum dose
was received, Maximum Dose Received in any single timestep.

7. Summary
This manual gives detailed instructions on how a user who is familiar with the design,
layout and potential hazards of a facility can use KBERT to assess the possible
consequences to workers in that facility. JCBERT is a tool that allows a user to simulate
possible accidents and observe the predicted consequences. Potential applications of
KBERT include the evaluation of the efficacy of evacuation practices, worker shielding,
personal protection equipment and the containment of hazardous materials.
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